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Module 1: Windows 10 Basics 

Objectives: 

• Getting Started (Page 2) 

• Interacting with Windows 10 using mouse and touch controls (Page 6) 

• Working with the Start Screen and Live Tiles (Page 10) 

• Logging out, shutting down and restarting Windows 10 (Page 14) 

Getting Started 

Overview 

The Windows 10 operating system builds on the touchscreen features that were introduced in 

Windows 8 and 8.1, but achieves a better compromise between touchscreen devices and Desktop 

PCs (using keyboard and mouse) than its predecessor.  If you are upgrading from Windows 7 or a 

previous version, you should find that transition easier with Windows 10 than with Windows 8 or 

8.1.  In particular, the Start Menu has been returned in the Desktop view. 

During these course notes, we shall refer to Windows 10 running in Tablet Mode and in Desktop 

Mode.) 

The opening ‘Lock’ screen 

When you turn your computer or device on, Windows 10 loads and you will be shown your lock 

screen (see Figure 1-1 below). 

 

Figure 1-1: Windows Lock screen 

This screen can be customised - it shows a picture, current date and time, battery life, and other 

information.  (If you want to change the picture and settings, refer to Module 4; Customising 

Windows 10.  Go to Settings, Personalisation, Lock Screen, to customise the Lock screen). 
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Step-by-step: 

To open the lock screen with touch: 

• Swipe the screen up with your finger 

 

To open the lock screen with mouse: 

• Click your mouse or press any key 

 

Once you have clicked on the Lock screen you will be then be shown the following login screen (see 

Figure 1-2 below). This feature ensures that no unauthorised users can access your system. Here you 

enter your password to access the system. If Windows ‘Hello’ has been set up on your machine, you 

may be required to log in using a fingerprint, PIN number, retina scan, or some other method.  

Once you have entered your password you are now shown the Start screen as shown in Figure 1-3 

and 1-4 below). 

 

 

Figure 1-2: Windows 10 Login Screen 
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Desktop/Start screen: 

 

 

Figure 1-3: Windows 10 Desktop mode Desktop 

 

 

 

Figure 1-4: Windows 10 tablet mode start screen 
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In Brief – Desktop mode and tablet mode 

Some Windows 10 devices run only in Desktop mode, and some run only in tablet mode.  Some can 

run both modes, in which case you can switch between the two modes using the ‘Tablet mode’ 

button in the Action Centre, as in Figure 1-5 below. 

 

 

 

Figure 1-5: Switch between Desktop mode and tablet mode 

 

The start screen colour and background can be customised – refer to Module 4. 
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Interacting with Windows 10 

Windows 10 is designed specifically to be equally usable in tablet mode (touch screen) or Desktop 

mode (conventional mouse and keyboard). 

Touch controls (tablet mode) 

Movement Action 

Tap: 

 

 

Tapping is like clicking with a mouse. Just tap an app to open it 

To select text within an app, tap it and then use the handles to adjust 

the selection 

Press and hold: 

 

Holding your finger on an object can do one of two things, depending 

on the app: 

• Display information about the object, much like hovering the 

mouse over an object 

• Display a context menu, much like right-clicking an object 

Swipe: 

 

By swiping a finger in from the edges and corners of the screen, you can 

perform different actions regardless of the app you have open: 

• Slide your finger across the screen to drag objects or scroll the 

screen or... 

• Swipe from the right edge of the screen to view action centre 

• Swipe from the left edge to show thumbnails of currently open 

apps (task view) 

• With an app open, swipe from the top of the screen to the side 

of the screen to allow you to use two apps side-by-side 

Pinch and zoom 

 

Some apps support pinching and stretching to zoom in and out. 

Zooming in allows you to see more detail, while zooming out shows you 

more context 

Rotate 

 

In some apps, you can also use two fingers to rotate objects on the 

screen. For example, you might use this to rotate a picture 
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Mouse controls and keyboard shortcuts (Desktop mode) 

Most of what you know about using a mouse and keyboard with Windows has remained the same. 

Here are a few ways to use the new Windows 10 features with a mouse and with keyboard shortcuts 

– and how to find some familiar things in new places.  

To do this With a Mouse With a Keyboard 

Open Action Centre 

(Notifications and 

Settings) 

Click on the Action Centre icon in the 

system tray (also known as the systray or 

notification area), in the bottom right-

hand corner of the screen. 

 

Action Centre: WINDOWS KEY +A  

Devices: WINDOWS KEY +K  

Settings: Windows key +I  

Share a screenshot to 

OneNote, email, or social 

media 

 WINDOWS KEY  +H  

 

Search (applications, 

settings, files, the web) 

Click into the Cortana ‘Ask me anything’ 

box in the bottom-left corner, and enter 

your search term.  Or to search using 

voice recognition, click on the microphone 

icon on the right-hand-side of the box. 

Open Cortana in typing mode: 

WINDOWS KEY +Q  

Open Cortana in listening mode: 

WINDOWS KEY +C  

Open Start menu Click on the Windows icon in the far 

bottom-left of the screen. 
WINDOWS KEY   

(PRESS THE SAME KEYS TO COLLAPSE THE START 

MENU) 
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To do this With a mouse With a keyboard 

Get to commands and 

context menus 

Right-click to see commands and context 

menus. Right-clicking on items often 

brings up options specific to that item. 

 

Use TAB or arrows keys to highlight 

things, then press SPACEBAR or ENTER 

View open applications.  Click on the Task View icon on the Task 

Bar (at the bottom of your screen) to view 

thumbnails of all currently open 

applications. 

 

To switch to a different application, 

simply click on it. 

 

(Note: on a device with limited resources, 

having many applications open will slow 

down performance.  Close unused 

applications by clicking on the ‘X’ in the 

top right-hand corner of the thumbnail.) 

WINDOWS KEY +TAB  

USE ALT+TAB TO SWITCH BETWEEN OPEN 

APPLICATIONS 

Snap an application to 

use two applications 

side by side 

 

Grab the Title Bar of the application with 

your mouse pointer and drag it to the left-

hand edge of the screen.  Drag the 

second application’s Title Bar to the right-

hand edge of the screen. 

 

Make an application 

full screen 

Grab the Title Bar of the application with 

your mouse pointer and drag it to the top 

edge of the screen or simply double-click 

on Title Bar. 
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To do this With a mouse With a keyboard 

Open the Desktop Click on the small area in the notification 

area in the bottom-right corner of your 

screen, to the right of the date and time. 

 

WINDOWS KEY +D 

Windows ‘Shake’ to 

minimize all but active 

application 

 WINDOWS KEY + HOME KEY 

Zoom in or out Many applications will allow you to zoom 

in and out by using Ctrl-scroll wheel.  

Ctrl and scroll wheel up to zoom in and 

Ctrl and scroll wheel down to zoom out.  

WINDOWS KEY + + (PLUS KEY) ZOOMS IN & 

SHOWS THE WINDOWS KEY MAGNIFIER 

TOOLBAR 

WINDOWS KEY + - (MINUS KEY) ZOOMS 

OUT (BACK TO ORIGINAL VIEW) 

 

Close an application  Click on the ‘X’ in the top right-hand 

corner of the applications.  

ALT+F4  

Shut down Right-click the Start button and select 

‘Shut down or sign out’. 

 

1. Press CTRL+ALT+DELETE 

2. Use the TAB key to move to the 

POWER icon in the bottom right-

hand corner, and click on it. A list of 

shutdown options appears. 

3. Use the up or down arrow keys to 

get to the option you want. 

4. Press ENTER.  
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Working with live tiles in Start (Desktop mode and tablet mode) 

The Start screen (tablet mode) and Start menu (Desktop mode) 

A version of the Start button and menu from previous versions of Windows has been brought back 

for Windows 10 in Desktop mode.  The live tiles on the Start screen in tablet mode behave in the 

same way as the live tiles on the Start menu in Desktop mode.  

‘Live’ tiles are more than just icons that launch applications.  Many tiles will show notifications; so, 

for example, the Mail tile will show how many unread items you have in your inbox, the Weather 

tile will show today’s weather, and the News tile will show you news headlines.   

Step-by-step: 

Start 

• Tablet Mode: Return to the Start screen by tapping the  Start button  

• Desktop Mode: Show the Start menu by moving the mouse pointer into the lower-

left corner of the screen and clicking on the  Start button   

Exercise: 

(Desktop mode) In the following exercise, you will practice opening and closing the Start 

menu. 

1.  The Desktop screen is showing  

2.  Click on Start The Start menu appears 

3.  Click on Start again The Desktop screen now appears 

4.  Press WINDOWS KEY  The Start menu appears 

5.  Press WINDOWS KEY  again The Desktop screen now appears 

and the Start menu collapses 

 

Moving, sizing and unpinning tiles on Start screen 

(refers to Desktop mode, but Tablet mode is very similar) 

On the Start screen, you can move the tiles so that your favourite ones are close at hand. You can 

also remove/unpin tiles that you will not use. To do this you will need to learn two more mouse 

techniques - how to drag items and use a right-click. 

Dragging items using the mouse 

Another mouse technique used in Windows is dragging. To drag an item, point at the item with your 

mouse pointer, press and hold the mouse button and then move the mouse pointer to another 

location. 

Dragging is a technique that is most commonly used to move items on the screen from one location 

to another. In addition, you will often drag to move items or text within Windows applications. For 

example, in Windows word processing applications, you can drag to move sections of text to new 

locations in a document. 
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Moving tiles in Start 

Tiles on the Start screen can be moved easily. For example, if you use Word and Excel you might 

want these icons right at the beginning of all of the tiles so that you can quickly access them.   

Step-by-step: 

To move tiles on the Start menu using dragging technique: 

1. Open the Start menu 

2. Use the mouse pointer to point at the tile you wish to move 

3. Press and hold down the mouse button 

4. Continue to press the mouse button while moving the mouse pointer to a new 

position 

5. Release the mouse button 

The other tiles will rearrange themselves to accommodate the moved tile 

Adding Tiles 

Step-by-step: 

 To add tiles to the Start menu using dragging technique: 

1. Open the Start menu 

2. Scroll down the list of apps that are listed alphabetically in 

the menu.  

3. Find the one you want (you many need to scroll up and 

down) and drag it onto the Start menu 

Alternatively; 

You can click your right-mouse button on the app and then 

select Pin to Start.   

 

 

 

Making a tile smaller or bigger 

You can also change the size of the tile – make it smaller or bigger. 

Step-by-step: 

To change the size of a tile on the Start screen: 

1. Right-click on the tile you wish to change the size of 

2. Hover the mouse pointer over ‘resize’ 
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3. Left-click on the size you require 

Exercise: 

In the following exercise, you will practice moving tiles and changing their size on the 

Start screen Desktop. 

1.  Move the mouse pointer to point 

at the Mail tile 

 

2.  Press and hold down the mouse 

button 

The tile shrinks slightly in size so 

that you know you have selected 

it 

3.  Continue to press the mouse 

button while moving the Mail tile 

to another location in the Start 

menu 

 

4.  Release the mouse button The Mail tile is now in the new 

location and all other tiles have 

moved to accommodate it 

5.  Move the Weather tile and place 

it beside the Mail tile 

The Weather tile is now beside 

the Mail tile and all tiles have 

moved to accommodate it 

6.  Right-click on Mail tile A context menu appears 

7.  Select resize then choose 

‘Medium’ 

The Mail tile has now changed 

size and the Weather tile moves 

to accommodate the new size 

8.  Move the tiles back to their 

original position and return them 

to their original size 

All tiles should be returned to 

their original position and size 
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Removing (‘unpinning’) tiles from Start 

Step-by-step: 

To unpin tiles from the Start menu: 

1. Right-click on the tile you wish to delete/unpin from the Start menu 

2. On the context menu that pops up, left click on Unpin from Start 

3. The tile is now removed from the Start menu 

Note: This does not uninstall the application from your device.  You can still find it 

in the ‘All apps’ list. 

Exercise: 

In the following exercise, you will remove/unpin a tile from the Start screen. 

1.  With the Start menu displayed, 

right-click on a tile that you don’t 

need (on a new device, there are 

usually several that are 

advertising games or paid-for 

apps) 

A context menu pops up 

2.  On the context menu choose 

Unpin from Start 

If you later change your mind, 

you will find this app in the 

alphabetical list of apps in the 

Start menu 

The tile is now removed from the 

Start screen 
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Logging out, shutting down and restarting Windows 10  

Signing out and shutting down Windows 10  

If your PC/Laptop/Tablet is shared, or if it has not been set to automatically ‘sleep’ after a period of 

inactivity, it is a good idea to either sign out or shutdown. Also, there may be times you need to 

restart your PC so that any changes made to your operating system can take effect. 

It is always a good idea to close any documents and applications you may have open before 

following any of the instructions below. 

Step-by-step: 

To sign out of Windows 10: 

1. Right-click the Start button  then hover your mouse pointer over ‘Shut down or 

sign out’ 

2. Left-click ‘Sign out’ 

To shut down Windows 10: 

1. Right-click the Start button  then hover your mouse pointer over ‘Shut down or 

sign out’ 

2. Left-click ‘Shut down’ 

To shut down using CTRL ALT DELETE: 

1. Press Ctrl Alt Delete 

2. Click mouse on Shut down icon (bottom right) 

3. Choose Shut down 

 

Restarting Windows 10 

If for any reason you wish to restart Windows 10, you can do so directly from the Start Menu, or can 

still use CTR+ALT+DELETE. You might use this option if you are installing new hardware or software or 

changing certain Windows 10 setup options. 

Step-by-step: 

To restart Windows: 

1. Right-click on Start 

2. Pont to Shut down or sign out  

3. Select Restart 

 

To restart using CTRL+ALT+DELETE: 

1. Press Ctrl+Alt+Delete. 
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2. Click mouse on Shut down icon (bottom right) 

3. Choose Restart 

4. The words Restarting appear on the screen, the machine shuts down and restarts 

and you will be presented with the Lock screen 

 

Exercise: 

In the following exercise, you will restart Windows 10. 

1.  Right-click the Start button A list of options appears. 

2.  Hover your mouse pointer over 

‘Shut down or sign out’ 

The popup menu appears. 

3.  Choose ‘Restart’ from the choices 

available 

You will be notified if there are 

any unsaved documents still open 

– giving you the opportunity to 

save them first 

Your computer reboots and 

Windows 10 restarts 
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Module 2: Using Windows 10 

Objectives: 

• Working with the Desktop (Desktop mode) and Windows (Page 16) 

• Working with the Quick Access Toolbar (Page 28) 

• Working with the Ribbon and dialog boxes (Page 29)  

• Getting Help and Support (Page 35) 

Working with the Desktop (Desktop mode) and Windows 

The Desktop 

When you open a Desktop application, it will be opened inside the Desktop area. On a new device, 

the Desktop area is initially relatively empty usually with just the Recycle Bin icon being displayed on 

the left of your screen in the main Desktop area, as illustrated in Figure 2-1 below. 

Just like your old Desktop in the earlier versions of Windows, you can add your own favourite 

Desktop icons. Icons are graphic representations of various elements of your computer, such as disk 

drives, folders, files or programs.  

 

Figure 2-1: Windows 10 Desktop with taskbar displayed at the bottom 

The taskbar, illustrated in Figure 2-2, is the long bar located at the bottom of the Desktop. The 

taskbar allows you to ‘pin’ your favourite programs to it, switch between active open Desktop 

programs and windows. 

 

Figure 2-2: Taskbar with additional programs added 
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In Brief – Apps or Applications? 

Windows Desktop applications that you buy from a third party and install via a CD or download link 

are known as “Windows Desktop Applications”.  These will be familiar to existing Windows users. 

Apps for Windows touchscreen/mobile devices were originally known as ‘Metro’ apps or ‘Windows 

8-style UI apps’.  They were available from the Windows Store, were optimised for small 

touchscreens, and were written using completely different code from regular Windows applications. 

With Windows 10, the plan is for application software to be written using the same code for both 

Desktop Mode and Tablet Mode.  These applications were initially known as ‘Universal apps’, but 

are currently known as ‘Windows apps’ or ‘Trusted Windows Store Apps’.  Figures 2-3a and 2-3b 

below show Microsoft Word 2016 running on Windows 10 in Tablet Mode and Desktop Mode 

respectively. 

 

Figure 2-3a Microsoft Word 2016 

in Tablet mode 

Figure 2.3b Microsoft Word 2016 

in Desktop mode 

You can see that Word looks almost identical in both cases, only with slightly larger Ribbon icons in 

Tablet mode. On a smaller tablet screen, Tablet mode may auto-hide the Ribbon, to allow more 

space to work on documents. 

Identifying parts of a window (Desktop mode) 

When you open a Desktop application it will be opened within a window, similar to the one you will 

see below which is a Microsoft Word 2016 window. All windows have the same common features as 

indicated below in Figure 2-3c (and discussed in more detail in Table 2-1). For each window that you 

have opened, a button with the window title appears on the taskbar.  
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Figure 2-3c: A typical Windows Desktop Application window 

 

Icon Description 

 

Minimise button - click to minimize a window to a button on the 

taskbar. 

 

Restore button - click restore the window to its previous size. 

(This has no effect in Tablet mode, when apps are either full-screen or 

in the background.) 

 

Maximise button - click to maximise the window to its full size. (This 

has no effect in Tablet mode, when apps are either full-screen or in the 

background.) 

 

Close button - click to close the window. 

 

Scroll buttons (at the top and bottom of the scrollbar) – use the 

up/down buttons to scroll the screen up/down, or drag the scrollbar 

elevator button 

 
   Title bar – (top centre of screen) - name of document/application 

Table 2-1: Window elements and descriptions 
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Moving and resizing a window 

Often when you open a window it may obscure parts of the Desktop or is not located where you 

want it to be. When this happens, you can move the window anywhere on the Desktop.  

Step-by-step: 

To move a window: 

1. In the window you wish to move, position the mouse pointer over title bar. 

2. Drag the title bar to a new location on the Desktop. 

 

To resize a window: 

1. Position mouse over the any corner of the window and you will see a double-

headed arrow. 

2. Click and drag the corner towards the middle or outwards to increase/decrease the 

size of the window. 

Note: If you drag the left, right, top, or bottom side of the window, only the side 

being dragged will change. If you drag a corner of the window, the window is sized 

both horizontally and vertically. 

Exercise: 

In the following exercise, you will move and resize a window. 

 1. Open Word – choose Start, select 

Word icon.  Choose blank 

document. 

Microsoft Word will open.  

 2. Position the mouse pointer over 

the title bar (Document 1 – 

Word). 

 

 3. Click and drag the title bar into 

the centre of the Desktop. 

The Word window shrinks in size 

(if it was opened full-screen) and 

moves into the centre of the 

Desktop. 

 4. Position the mouse over any 

corner of the window. 

A double headed arrow appears. 

 5. Drag the corner towards the 

middle of the Desktop. 

The window gets smaller. 

 6. Drag the corner towards the 

outside edge of the Desktop. 

The window gets bigger. 
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Maximizing, restoring, and minimizing a window (Desktop mode) 

If you are working with a program, such as a word processing or spreadsheet program, you will 

usually want to see as much of the document you are working with as possible. By maximizing your 

program window, you can fill the entire Desktop with the program window, making its 

contents easy to see and work with. This button is indicated in Table 2-1 (page 18).  

Once you have finished working with a maximized window, you may want to restore it to its 

previous size so that you can work with other windows on the Desktop. This is done by 

restoring the window. You restore a window by clicking the Restore button, as indicated in 

Table 2-1 (page 18).  

The Restore button appears only if the window is maximized, and the maximise button appears only 

if the window is restored. 

When you have multiple windows open and you enlarge one, you may cover up other windows. 

Sometimes it becomes hard to keep track of all the open windows. You can reduce windows to 

buttons on the taskbar to help organize the Desktop. This is called minimizing a window. When you 

minimize a program window to a button, you do not quit the program; instead, you merely reduce 

the space the window takes up on your Desktop. The program continues to run until you 

close it. To reopen the minimized window, click its button on the taskbar. The minimise 

button is indicated in Table 2-1 (page 18).  

Step-by-step: 

To maximize a window: 

• Click the  Maximize button 

• To restore a maximized window to its previous size, click the  Restore button 

To minimize a window: 

• Click the  Minimise button 

• To restore a minimised window, click the desired button/icon on the taskbar 
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Exercise: 

In the following exercise, you will practice maximizing, restoring and minimizing a 

window. 

1.  Using the Word window, you had 

opened in the previous exercise, 

click Maximize button 

The Word window fills the entire 

screen 

2.  Click Restore button The Word window is restored to 

its original size and location on 

the Desktop 

3.  Click Minimize button The Word window is reduced to 

an icon on the taskbar 

4.  On the taskbar, click Word icon The Word Window now opens 
 

Scrolling in a window 

Often a window is not large enough to allow all its contents to be seen. When some of the contents 

are hidden from view, scroll bars appear in the window, as shown in Figure 2-4 below. By clicking the 

scroll arrows, located at either end of the scroll bar, you can move up and down through a window. 

You can also drag the elevator button in the scroll bar to move through the window.  If you have a 

mouse wheel, you can also use your mouse wheel to scroll up/down. 

 

Figure 2-4: Windows Scroll Bar 

  



Windows 10 – Introduction Module 2: Using Windows 10 

www.ldnh.co.uk  Page 22 of 85 

Step-by-step: 

To scroll in a window by using scroll arrows: 

1. Position the mouse pointer on a scroll arrow; 

 or  

2. Click the mouse button to move line by line OR press and hold the mouse button 

until you see the desired section of the window. 

 

To scroll in a window using the elevator button: 

• Position the mouse pointer on the elevator button. Drag the elevator 

button in the scroll bar until you see the desired section of the window OR 

use the mouse wheel to scroll up/down. 

 

Exercise: 

In the following exercise, you will practice scrolling in a window. 

1.  Ensure that the Word window is 

maximized. 

The Word window is maximized 

to full size. 

2.  At the bottom of the vertical 

scroll bar, position the mouse 

pointer on the down scroll arrow 

 

3.  Click the mouse button. The window scrolls up down line. 

4.  Press and hold the mouse button 

on the down scroll arrow. 

The window scrolls down quickly. 

5.  Release the mouse button.  

6.  In the vertical scroll bar, position 

the mouse pointer on the elevator 

button. 

 

7.  Drag the elevator button to the 

top of the vertical scroll bar. 

The window scrolls up. 

8.  Release the mouse button.  

9.  Choose Close (X) button to close 

Word. 

 

 

 



Windows 10 – Introduction Module 2: Using Windows 10 

www.ldnh.co.uk  Page 23 of 85 

Opening multiple windows (Desktop mode) 

(Note that you can only have multiple windows open in Desktop mode.  In Tablet mode, you may 

only have a maximum of two windows both open and visible at once, and you achieve this by 

dragging the title bar of an app to one side of the screen.  The next app you open will occupy the 

other half of the screen.) 

 

In Desktop mode, you will often wish to work with more than one window at a time. This is useful if 

you want to copy information between applications or if you wish to compare information contained 

in different applications. You can open multiple windows in the same way that you open a single 

window. Simply open the first window you wish to work with and then open another window you 

wish to view. 

Step-by-step: 

To open multiple windows: 

1. Open the first window you want to work with. 

2. Open another window you want to work with. 

Exercise: 

In the following exercise, you will open multiple windows. 

1.  Open Word and click Blank 

document. 

Word opens with a blank 

document. 

2.  Open Excel and click Blank 

workbook. 

Excel opens with a blank 

workbook. 

3.  We now want to position the 

windows side by side. 

 

4.  Drag the Word title bar to the 

centre of the screen and resize 

the window to make it smaller. 

The Word window decreases in 

size. 

5.  Drag the Excel title bar to the 

centre of the screen and resize 

the window to make it smaller. 

The Excel window decreases in 

size. 

6.  Move the windows so that they 

are side by side. 

The windows are now side by 

side. 
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Switching between windows (Desktop mode) 

You can have many windows open on your Desktop at the same time, but there can be only one 

active window—in other words, you can work in only one window at a time. The active window 

always appears as the foreground window, overlapping any inactive windows and its title bar is 

highlighted. 

Step-by-step: 

To switch between windows: 

1. Click anywhere in the window you want to make active OR choose the button on the 

taskbar for the window you want to make active. 

2. The windows title bar becomes active. 

 

 

Figure 2-5: Overlapping windows 
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Exercise: 

In the following exercise, you will practice switching between windows. 

1.  Position the windows so that they 

overlap as per Figure 2-5 

 

2.  Click anywhere in the Excel 

window 

The Excel window becomes active. 

3.  Click anywhere in the Word 

window 

The Word window becomes 

active. 

4.  On the taskbar, click Excel icon The Excel window becomes active. 

5.  On the taskbar, click Word icon The Word window becomes 

active. 

6.  Keep both windows open  

 

 

Using taskbar to quickly reposition windows (Desktop mode) 

You can also use the taskbar to quickly reposition your windows, saving you the time and trouble of 

manually resizing them and moving them – see Figure 2-6 below. 

In Windows 10 you can have multiple applications open at the same time. 

 

Figure 2-6: Using taskbar repositioning options 
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Step-by-step: 

To quickly reposition windows side by side: 

1. With your windows open. 

2. Right click on taskbar and choose Show windows side-by side. 

3. Your windows should now be positioned side by side vertically. 

 

Figure 2.6a: Side-by-side windows 

 

To stack windows horizontally: 

1. With your windows open. 

2. Right click on taskbar and choose Show windows stacked. 

3. Your windows will now reposition stacked horizontally with one window at the top 

and the other at the bottom. 

 

Figure 2.6b: ‘Stacked’ windows 

 

To cascade windows: 



Windows 10 – Introduction Module 2: Using Windows 10 

www.ldnh.co.uk  Page 27 of 85 

1. With your windows open. 

2. Right click on taskbar and choose Cascade windows. 

Your windows will now stack behind each other, overlapping slightly. 

Exercise: 

In the following exercise, you will practice repositioning windows using the taskbar 

1.  Position the windows so that they 

overlap as per Figure 2-5 on 

page 24. 

 

2.  Right click on the taskbar and 

choose Cascade windows. 

The windows are stacked behind 

each other. 

3.  Right click on the taskbar and 

choose Show windows stacked. 

The windows are stacked 

horizontally. 

4.  Right click on the taskbar and 

choose Show windows side by 

side. 

The windows are repositioned 

side by side. 

5.  Close all windows.  

 

Snapping windows 

Since Windows 7, windows may be snapped to either the left or right side of the screen. 

Step-by-step: 

To ‘snap’ a window: 

1. Using your mouse pointer, grab the title bar of the application. 

2. Drag your mouse pointer to either the left or right-hand edge of the screen. 

3. The application will snap to either the left or right half of the screen. 

Exercise: 

In the following exercise, you will practice snapping windows to the edges of the screen. 

1.  Using the Word and Excel 

windows as before, drag the title 

bar of the Excel window to the 

right-hand edge of the screen 

The Excel window now occupies 

the right-hand half of the screen 

2.  Drag the title bar of the Word 

window to the left hand edge of 

the screen 

The Word window now occupies 

the left-hand half of the screen 

and the two windows appear 

side-by-side 

3.  Now grab one of the windows 

using your mouse pointer on the 

title bar, and drag it to the top 

edge of the screen 

That window is now maximised 
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Using ‘Shake’ 

Windows Shake (which has been around since Windows 7), allows you to minimize all but the active 

document window. This could be particularly useful, for example, when you need a distraction-free 

desktop when you might be reading an important document in say Microsoft Word or a pdf viewer.  

Step-by-step: 

To ‘shake’ a window and minimize all other windows: 

1. Using your mouse pointer, grab the title bar of the active application. 

2. Holding down your mouse button – shake the window by dragging right and left 

a few times. 

3. All open windows, except the one you are holding, will now be minimized to the 

taskbar. 

Note: you can also use the WINDOWS KEY + HOME KEY.  Press the same two keys 

again to restore the windows back to their original size and locations. 

 

Working with the Quick Access Toolbar 

The Quick Access Toolbar (QAT) was introduced in Office 2007. The QAT can be moved above or 

below the ribbon. You can very easily add your favourite commands to it (as shown in Figure 2-7).  

 

Figure 2-7: Customising Quick Access Toolbar 

Step-by-step: 

Repositioning QAT above/below the ribbon: 

1. In *Word, click the drop-down arrow at the end of the QAT, (click Customise Quick 

Access toolbar). 

2. You will be shown a drop down list (refer to Figure 2-7). 

3. Choose Show Below the Ribbon or Above the Ribbon. 
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* The same steps would be followed in File Explorer, Excel, PowerPoint etc. 

 

Adding popular commands to the QAT: 

1. Click the drop-down arrow at the end of the QAT (Customise Quick Access toolbar). 

2. Select one of the popular commands to quickly add it to the QAT (eg Print Preview 

and Print) 

That command is now added to the QAT. 

 

Adding commands to QAT using right click: 

1. Another way of adding a favourite command to the QAT is by right clicking on the 

command on the ribbon. For example, in Word click the Home tab and then right 

click on Bullets button in the Paragraph group. 

2. Choose Add to Quick Access Toolbar. 

This button is now added to the QAT. 

 

Removing commands to QAT using right click: 

1. The easiest way to remove a command from the QAT is to right click on the 

command you wish to delete on the QAT. 

2. Choose Remove from Quick Access Toolbar. 

This button is now removed. 

 

Exercise: 

In the following exercise, you will practice using the QAT in either Word or Excel. 

 

1.  Position the QAT below the 

ribbon 

The QAT moves below the ribbon 

2.  Position the QAT above the 

ribbon 

The QAT moves above the ribbon. 

3.  Add Cut button to the QAT The Cut button is now added to 

the QAT 

4.  Remove Cut button from the 

QAT. 

The Cut button is now removed. 

Working with the Ribbon 

The ribbon replaces the toolbars, which were part of the old Windows’ versions from years ago. 

Below is the new File Explorer (previously known as Windows Explorer) window (see Figure 2-8). File 

Explorer helps you to organise your documents into folders so that you can quickly find your 
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documents and will be covered in detail Module 3. The ribbon can also be minimised or maximised 

to give you more space on your screen. 

 

Figure 2-8: The New File Explorer window 

 

The File Explorer now has a ribbon where you can find your commands as shown in Figure 2-9 

below. The buttons available on the ribbon will vary, but this is showing the View tab with the C: 

drive highlighted. 

 

Figure 2-9: Example of the new ribbon in File Explorer 

 

In Windows 10 you carry out most actions by choosing commands from the ribbon. Some of the 

commands require that you input information or select options in a dialog box.  

Step-by-step: 

Minimising/maximising the ribbon; 

• In File Explorer, choose Minimise the Ribbon button  or Expand (Maximise) 

the Ribbon button  displayed on top right hand side of screen or press CTRL + 

F1. 

To use the ribbon; 
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1. Choose the ribbon tab you wish to use e.g. View 

2. The View ribbon options are now displayed 

3. Click on the command you wish to use 

To cancel commands/menu choices: 

1. If a dialog box is open - press ESCAPE or choose Close button 

2. If a drop down list is open – position the mouse pointer outside the drop down list 

and click the mouse or press ESCAPE 

 

Ribbon/command conventions 

Menu Convention Example... Meaning 

Menu command is dimmed The command does not apply to the current 

situation and you cannot choose it. 

Menu command is followed 

by a small triangle  

 

Choosing the menu command brings up a 

submenu which allows you to choose 

additional options. 

Check mark appears to the 

left of a menu command 

 

The command is currently in effect. Choose 

the command again and the check mark 

disappears, indicating that the command is 

no longer in effect. 

Table 2-2: Menu conventions 
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Exercise: 

In the following exercise, you will practice using menus. 

 

1.  Open File Explorer using the File 

Explorer icon on the taskbar.  

Opens Desktop and the File 

Explorer window opens. 

 

 

2.  Choose View tab. The View tab shows all of the 

possible commands available. 

3.  On left hand side choose 

Documents folder (under This PC) 

– this is where all of your 

documents will be stored. 

The Documents folder displays 

sub folders. 

4.  Choose Home tab.  The Home tab shows all of the 

possible commands available.  

5.  Choose View tab and select 

Extra-large icons. 

The folders are now displayed 

extra-large. 

6.  From View tab, choose Medium-

sized icons. 

The folders are now displayed in 

medium size. 

7.  On View tab, choose Sort by A drop down list appears. 

8.  Click the Sort by button again The list closes. 

9.  Choose Home tab and click on the 

Properties button. 

A dialog box opens. 

10.  Choose Close icon or Cancel 

button, or press ESCAPE to close 

the dialog box. 

The dialog box now closes. 

11.  Now close File Explorer by 

choosing Close button. 

File Explorer now closes. 
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Dialog box elements 

Dialog boxes appear when Windows 10 needs information from you to execute a command. For 

example, a dialog box appears when you choose the Paragraph command in Word 2016. To format a 

paragraph, you use the dialog box to specify the alignment, indentation, and spacing. In some dialog 

boxes, default choices are already filled in for you and you simply need to confirm these selections. 

Parts of a typical dialog box are shown in Figure 2-10 below. Windows 10 dialog boxes incorporate 

easy-to-use features that allow you to select the options you want to use.  

 

  

Figure 2-10: A typical dialog box 
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Exercise: 

In the following exercise, you will practice using list boxes and drop-down list boxes. 

 

1.  Start Microsoft Word & create a 

new blank document 

A blank document appears. 

2.  Type a few words at the top of 

the document and then press the 

Enter key twice 

Word displays the text using the 

default formats. 

3.  On the Home tab of the ribbon 

click the Font dialog launcher 

button in the bottom right corner 

of the Font group 

The Font dialog box appears. 

4.  Use the scrollbar to select a text 

size of 18 points 

Click the drop-down arrow 

underneath Underline style: and 

select a double-underline 

Tick the All caps: checkbox 

The preview window displays an 

example of what your text will 

now look like. 

5.  Click OK The dialog box closes and you are 

returned to your Word document. 

6.  Start typing some text 

(underneath your previous text) 

The text displays using your new 

‘Font’ formats 

7.  Close down the Word program 

without saving your changes 
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Getting Help and Support 

Help and Support 

You can readily get help with your windows program by accessing the Help System using Cortana as 

shown below in Figure 2-11. 

 

Figure 2-11: Accessing Help and Support using Cortana 

Step-by-step 

To access help and support: 

1. Click in the Cortana text-entry box; 

 

2. Type your entry directly into the text-entry box (you don’t need to press the ENTER 

key) 

3. Cortana shows a list of things that ‘she’ can help you with 

Note: 

• If you are looking to find an app that you have on your PC (but can’t find it easily), 

type the name of the app in Cortana (eg Calculator) and then click the Find results 

in apps icon; 
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Cortana will then display a list of related installed apps that are installed on your PC 

• If you are looking to find a particular document on your PC (it could be a Word or 

Excel document); type either the filename or any text that is contained within the 

document and then click the Find results in documents icon; 

 

Cortana will display a list of documents containing the search filename or text, with 

the best match shown at the top of the list. 

• The 3rd icon at the top of the Cortana search lets you search results from the web; 

 

 

Another method to get help online: 

1. Click on an empty section of Desktop 

2. Press F1 

3. The Microsoft Bing web page opens with a search text box at the top 

4. Enter your search text directly into the search box at the top of the page and press 

ENTER 
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To get help on a specific problem: 

1. Type your question in the Cortana text entry box, for example, “how do I add a 

printer?” 

2. Cortana’s results may include Microsoft help, web searches, or links to where you 

can change your computer’s settings 

Note: In apps and Desktop applications, you can also press F1 to access Help or 

choose the Question Mark in dialog boxes. 

Exercise: 

In the following exercise, you will get help on a topic. 

 

1.  In Cortana’s text entry box, type, 

“how do I add a printer?” 

Cortana returns a list of possible 

solutions 

2.  Click on the ‘Best match’ solution, 

labelled with a question mark and 

“Help from Microsoft” 

You are given instructions on how 

to add a printer 

3.  Click back in Cortana’s text entry 

box and type. 

“What is the weather 

tomorrow?” 

(This assumes that your computer 

has been set up to be location 

aware) 

Cortana will automatically display 

a summary of tomorrow’s 

weather in your region 

4.  Click back in the search box and 

type “Calculator” 

Cortana shows the Calculator app 

under ‘Best Match’ 

5.  Click on Calculator under ‘Best 

Match’ to load the calculator app 

The Calculator app loads in a 

separate window 

6.  Try it out and then close the 

Calculator app 

 

 

  



Windows 10 – Introduction Module 2: Using Windows 10 

www.ldnh.co.uk  Page 38 of 85 

 

Assignment 

 

 

1. Open File Explorer 

2. Use the Close button to close the window 

3. Open File Explorer and move it to a different place on the Desktop 

4. Maximize File Explorer window 

5. Restore File Explorer window 

6. Move File Explorer window to the centre of the Desktop 

7. Resize File Explorer window 

8. Open the Recycle Bin from the desktop 

9. Make File Explorer window the active window 

10. Snap the two windows to each side of the Desktop 

11. Close File Explorer window 

12. Use the Cortana to search for the Snipping Tool 

(The Snipping Tool is a tool that can be used to ‘capture’ parts of the screen, which can then be 

copied into documents – great for training manuals like this) 

13. Click your right mouse button on the Snipping Tool Desktop app... 

 

...and select Pin to Start 

14. In the Start menu, find the Snipping Tool and move it to another part of the Start menu 

15. Unpin the Snipping Tool from the Start menu. 

16. Close all dialog boxes which are open on the Desktop 

17. Logout of Windows 10 
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Module 3: Managing Files 

Objectives: 

• Using File Explorer (Page 39) 

• Working with Folders and Files (Page 45) 

• Moving, Copying and Renaming Files/Folders (Page 48) 

• Finding your Files/Folders (Page 54) 

• Using the Recycle Bin (Page 55) 

• Sharing Information between programs (Page 58)  

Using File Explorer 

File Explorer (previously called Windows Explorer) helps you browse locations on your PC and 

network and work with files and folders.  

Starting File Explorer 

Although there are several ways to start File Explorer, the most direct way is by clicking the File 

Explorer shortcut icon on the Desktop taskbar (shown in Figure 3-1). 

 

Figure 3-5: File Explorer icon on Taskbar 

Step-by-step: 

To open File Explorer: 

• Click File Explorer icon on taskbar located bottom left hand corner; 

 
The File Explorer window now opens. 

Note: - an underscore shown on any of the icons on the taskbar indicates that that 

particular application is running 
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Exercise: 

In the following exercise, you will start File Explorer. 

 

1.  Close any windows that you have 

open and show the Desktop. 

The Desktop is visible. 

2.  Click File Explorer icon on 

Taskbar. 

File Explorer opens and displays 

information about your computer. 

 

 

Identify the different parts of the File Explorer window 

 

Figure 3-2: The main elements of File Explorer Window 

 

 

Window part: What it's useful for: 

 
Navigation pane Use the navigation pane to access all kinds of locations: 

folders you have pinned to your ‘Quick access’ list, the drives 

on your PC and other PCs on your network. Tap or click on a 

location to view its contents in the file list, or tap or click an 

arrow to expand a location in the navigation pane. To browse 

1 
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Window part: What it's useful for: 

your PC's drives and the folders in them, expand This PC (as 

shown). 

 
Back, Forward, and Up 

buttons 

Use the � Back button to go back to the last location or 

search results you were viewing and the � Forward button 

to return to the next location or search results. Use the � Up 

button to open the location where the folder you are viewing 

is saved (sometimes called the parent folder).  

 
Ribbon Use the ribbon for common tasks, such as copying and 

moving, creating new folders, emailing and zipping items, 

and changing the view. The tabs change to show extra tasks 

that apply to the selected item. For example, if you select 

This PC in the navigation pane, the ribbon shows different 

tabs than it would if you select a picture in your Pictures 

folder. If you do not see the ribbon, tap or click Expand the 

Ribbon button in the upper right (like a ^) or press CTRL+F1.  

 
Address bar Use the address bar to enter the full path to a file or folder. 

Tap or choose a part of the path to go to that level, or tap or 

click at the end of the path to select the path for copying.  

 
File and folder list This is where the contents of the current folder or drive are 

displayed. It is also where your search results appear when 

you enter a search term in the search box. 

 
Column headings In Details view, you can use the column headings to change 

how the files in the file list are organized. For example, you 

can tap or choose ‘Date modified’ heading to sort by date 

(with the files you worked on most recently at the top). If you 

tap or click the column heading again, the files are sorted 

with the oldest ones at the top. Press & hold (tablet mode), 

or right-click (Desktop mode) a column heading to select 

other columns to add. 

 
Search box Enter a word or phrase in the search box to look for an item 

in the current folder. The search begins as soon as you begin 

typing—so if you enter "B" for example, all the files with 

names starting with the letter B will appear in the file list. 

Note: indexed file locations will be searched much quicker 

than those that aren’t; search Cortana for ‘Indexing options’ 

to learn more about indexing. 

2 

3 

4 

5 

6 

7 
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Window part: What it's useful for: 

 
Status bar Use the status bar to quickly see the total number of items in 

a location, or the number of selected items and their total 

size.  At the far right of the Status bar there are two small 

buttons that enable you to quickly switch between a ‘Details’ 

view and a ‘Thumbnails’ view. 

Details pane Use the details pane to see the detailed properties associated 

with the selected file. If you don’t see the details pane, tap or 

choose the View tab, and then tap or click on Details pane. 

File properties provide detailed information about a file, such 

as the author, the date you last changed the file, and any 

descriptive tags you might have added to the file.  

Preview pane Use the preview pane to see the contents of a file, such as an 

Office document, without opening it in an app. If you don’t 

see the preview pane, tap or choose the View tab, and then 

tap or click on Preview pane.  (Note: using the preview 

pane may cause errors when you want to delete a file, 

because the file will be ‘in use’.  If you get a ‘file in use’ 

error when trying to delete a file, try closing the preview 

pane.) 

 

When Windows 10 is first set up, it creates default folders for you for Documents, Downloads, 

Music, Pictures, and Videos.  Unless your network administrator tells you otherwise, it is best to 

keep your content in the appropriate folder. 

 

 

Figure 3-3: The default folders created by Windows 10 

8 
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Using the File Explorer ribbon 

In File Explorer, a ribbon is displayed that allows you to quickly perform tasks, such as changing the 

window view, organize files and folder, or copy information to a CD or DVD.  

This ribbon will differ depending on what you are viewing in File Explorer, for example, if you are 

viewing the contents of ‘This PC’ and you choose the Computer tab, you will see different commands 

available as shown in Figure 3-5 below. 

 

Figure 3-5: The File Explorer ribbon showing commands for Computer tab 

Step-by-step: 

Collapsing and expanding ribbon: 

1. Open File Explorer. 

2. Choose Documents folder. 

3. The ribbon is displayed. If you want to collapse the ribbon, choose ^ icon (near help 

icon in the top right) to collapse the ribbon. 

4. If the ribbon is collapsed, click the same icon again (which has now turned upside 

down) to expand the ribbon. 

 

Changing window view options 

When you open a folder, you can change how the files appear in the window. For example, you 

might prefer larger (or smaller) icons or a view that lets you see different kinds of information about 

each file. To make these kinds of changes, use the View tab as shown in Figure 3-6 below. 

 

Figure 3-6: View tab 

Step-by-step: 

To change view options: 
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1. Select the View tab 

2. Choose the desired view in the Layout group 

Exercise: 

In the following exercise, you will change the View options for the Data folder. 

 

1.  Select the Documents folder and 

choose Data 

The contents of your Data folder 

are displayed 

2.  From View tab, choose Large 

Icons 

The Data folder view changes to 

Large Icons 

3.  From View tab, choose List The view changes to List the 

folders and files 

4.  From View tab, choose Details The view changes to Details 

which shows date, type size etc 

 

Note: 

When you switch to Details view, File Explorer will show the data in columns in the ‘File and 

Folder’ list.  The example below shows the contents of the ‘Data’ folder in Details view.  

Notice the headings showing for each file; ‘Name’, ‘Date Modified’, ‘Type’ and ‘Size’; 

 

By default, the data will be sorted in alphabetical ascending ‘Name’ order, but if you wish to 

sort by another column, eg ‘Date modified’; simply click on that heading. If you click on a 

column heading twice it will sort in descending order rather than ascending order.  You 

may get different column headings if you select a folder that contains pictures, music or 

video. 
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Working with Folders 

Creating a new folder 

You can create folders to help organize your files. You can even create folders within folders 

(sometimes called subfolders). 

Step-by-step: 

To create a new folder: 

1. Click on the folder where you wish to create your subfolder e.g. ‘Documents’ under 

‘This PC’.  

 

2. Select Home tab 

3. Select New Folder in the New group 

4. The new folder appears, type the folder name 

5. Press ENTER 

6. Your new folder is created 

Note: Shortcut key to create a new folder is Ctrl Shift N 
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Exercise: 

In the following exercise, you will create a new subfolder within the Documents folder. 

 

1.  In File Explorer, click on the 

Documents folder in the 

navigation pane. Double-click on 

Data folder in the main pane. 

You are now in the Data folder 

ready to create your new folder. 

2.  Select the Home tab. The Home ribbon appears. 

3.  Click New Folder. A new folder named New Folder 

appears in the window. 

4.  Type Monthly Reports. The name New Folder is replaced 

with Monthly Reports. 

5.  Press ENTER. The new folder is named and it is 

a subfolder of Data. 

 

Renaming a folder 

There are times when you might need to give an existing folder a more appropriate name. You can 

easily rename a folder. 

Step-by-step: 

To rename a folder: 

1. Click on the folder you wish to rename. 

2. Select Home tab. 

3. Click Rename. 

4. Type the new name. 

5. Press ENTER. 

6. Your folder is renamed. 

Note: You can also right click on a folder and choose Rename or click on the folder 

and press the F2 function on your keyboard. 
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Exercise: 

In the following exercise, you will rename the ‘Reports’ folder to ‘Reports 2016’. 

 

1.  Click on the Monthly Reports 

folder  

The folder is now selected. 

2.  Select the Home tab The Home ribbon appears. 

3.  Click Rename  

4.  Type Reports 2016 The new name replaces the old 

folder name. 

5.  Press ENTER The folder is now renamed. 

 

Deleting a folder and its contents 

Sometimes you may want to delete a folder and all of its contents as you may not require the 

information anymore. 

Step-by-step: 

To delete a folder and its contents: 

1. Click on the folder you wish to delete. 

2. Select the Home tab. 

3. Click on the drop-down arrow just under the Delete button. 

4. Choose Recycle, if you want to place the file in the Recycle bin where you can 

recover it OR choose Permanently delete, if you want to permanently delete the 

folder (you will not be able to recover the information). 

5. Your information is now placed in the Recycle bin or permanently deleted. 

Note: You can also use the keyboard shortcut Shift Delete to permanently delete a 

file. 
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Exercise: 

In the following exercise, you will create and delete a folder. 

 

1.  In File Explorer, make sure the 

Data folder is selected. 

 

2.  Create a new folder and name it 

Budgets 2016. 

A new folder appears in the 

Contents window. 

3.  Press ENTER. The folder is created and named. 

4.  Select Budgets 2016 folder. The folder is now selected. 

5.  Choose Home tab and click 

Delete drop-down. Choose 

Recycle. 

The folder is deleted and placed in 

the Recycle bin. 

 

Moving, Copying and Renaming Files 

You can rename, copy, move and delete files using File Explorer quickly and easily using commands 

in File Explorer. However, before looking at these commands, it is worth looking at how you can 

select multiple files. 

 

Selecting more than one file to move or copy using Item Check Boxes 

One useful feature in Windows 10 is the ability to select more than one file to move or copy using 

Item Check boxes. This feature is located on the View tab, in the Show/Hide group. 

 

 

Figure 3-8: Item check box feature on View tab 
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Step-by-step: 

To turn on/off Item check boxes: 

• Choose View tab, in Show/Hide group, select (tick) Item check boxes. 

 

Selecting several files using Item check boxes: 

1. Open the folder and display the files. 

2. Click to the left of the file you wish to select. 

3. A tick appears in the box to show you that you have selected it. 

4. Continue selecting files that you wish to move or copy. 

5. Once you have selected the files, you can then choose delete, move or copy as 

required. 

Tip: To quickly deselect all files, click Home tab, and then click Select none. 

 

Selecting several files using the Shift and Ctrl keys: 

1. Open the folder and display the files. 

2. Click on a file you wish to select. 

3. Hold down the Ctrl key and continue selecting files that you wish to select.   

(To select a block of adjacent files in a list, click on the first file at the top of the block 

and then hold down the Shift key and select the file at the bottom of the block.) 

4. Once you have selected the files, you can then choose to delete, move or copy as 

required. 

Tip: To quickly deselect all files, click Home tab, and then click Select none. 

Exercise: 

In the following exercise, select files using Item check boxes: 

1.  Ensure Data folder contents is 

displayed. 

The Data folder is expanded and 

the folders it contains are 

displayed below it. 

2.  Check that you are in the correct 

view with files sorted 

alphabetically by name.  (Click 

the View tab and select Details in 

the Layout group) 

All the files’ details show and they 

will be in alphabetical name order 

3.  Click View tab, in Show/Hide 

group, select Item check boxes. 

An extra column appears to the 

left of the Name column 

4.  In the File list, position the mouse 

pointer to the left of the file 

Holiday Resorts and click. 

Holiday Resorts now has a tick 

against the file name. 

5.  Now also select the files, Cycle 

Touring and Centennial Meetup. 

These files should now have a tick 

to the left of the file name. 



Windows 10 – Introduction Module 3: Managing Files 

www.ldnh.co.uk  Page 50 of 85 

6.  Now deselect the files; click the 

Home tab and then click Select 

none in the Select group  

None of the files are selected and 

the tick marks have gone. 

7.  Now select an adjacent group of 

files; click on the Athena Jones 

file at the top of the list, hold 

down the Shift key and select the 

Directions to Conference file 

A block of 6 files will be selected 

(note the number count on the 

status bar at the bottom of the 

File Explorer window) 

8.  Now deselect the files; click the 

Home tab and then click Select 

none in the Select group OR 

simply click on an empty space 

alongside the files 

None of the files are selected and 

the tick marks have gone. 

9.  Now select all the files; click the 

Home tab on the ribbon and then 

choose Select all in the Select 

group OR simply press the Ctrl A 

shortcut on your keyboard 

All the files are selected 

10.  Now deselect the files; click the 

Home tab and then click Select 

none in the Select group OR 

simply click on an empty space 

alongside the files 

None of the files are selected and 

the tick marks have gone. 

11.  Close File Explorer File Explorer is now closed 

 

Copying and Moving Files 

When you move a file, you are removing it from its original location and placing it in a new location. 

When you copy a file, you leave the file in its original location and make a duplicate in a new 

location. 

There are different methods you can use to copy and move your files, but the original ‘Copy and 

Paste’ to copy and ‘Cut and Paste’ to move are generally the most useful methods. 

It is also worth noting that you can move/copy to Microsoft’s cloud storage service OneDrive 

(formally known as SkyDrive).  A Windows 10 account comes with 5GB of free cloud storage.  The 

OneDrive folder appears in File Explorer just like any other folder, but it synchronizes with the cloud, 

which means that you have access to the same files if you log in to another Windows 10 device, such 

as a tablet or phone, using the same account.  Cloud storage services are also available from 

Dropbox, Adobe Creative Cloud, and Google, and these add icons to File Explorer in the same way. 
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Step-by-step: 

Moving files: 

1. Select the folder(s) that you wish to move,  

or select the individual file(s) that you wish to move. 

2. Select the Home tab on the ribbon. 

3. Click the Cut button in the Clipboard group. 

4. Select the location where you wish to move the folder/file(s) to. 

5. Click the Paste button in the Clipboard group. 

The folder(s)/file(s) are moved to the new location. 

 

Copying files: 

1. Select the folder(s) that you wish to copy,  

or select the individual file(s) that you wish to copy. 

2. Select Home tab on the ribbon. 

3. Click the Copy button in the Clipboard group. 

Select the location where you wish to copy the folder/file(s) to.  

The folder(s)/file(s) are copied to the new location. 

Exercise: 

In the following exercise, you will move and copy files between folders. 

 

1.  Ensure File Explorer is open and 

the Data folder is selected. 

 

2.  Open the Data folder. The data folder is now open. 

3.  Select the Planning Meeting 

Word file. 

The file is selected. 

4.  Click Home tab, select Cut button 

in the Clipboard group. 

Depending on your current view, 

the file icons will ‘fade’ 

5.  Select the destination folder; click 

on the Reports 2016 folder under 

the Data folder 

The Reports 2016 folder is now 

selected. 

6.  Click Paste on the Home tab of 

the ribbon. 

The file is now moved to Reports 

2016. 

7.  Return to and open the Data 

folder to confirm that the 

Planning Meeting file is no longer 

there 

 

 We are now going to create a 

new folder called Meetings 2016 

and place a copy of the file 

Planning Meeting in this folder. 
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8.  Select the Data folder and create 

a new folder called Meetings 

2016. 

A new folder is created as a sub 

folder of Data. 

9.  In the Reports 2016 folder, select 

the file Planning Meeting. 

The Planning Meeting file is now 

selected. 

10.  Select Home tab.  Click Copy in 

the Clipboard group.  

 

11.  Now return to your Data folder 

and open the Meetings 2016 

folder 

 

12.  Now click Paste to place a copy of 

the Planning Meeting file in that 

folder too 

A copy the Planning Meeting file 

is now placed in this folder 

13.  Check both the Reports 2016 and 

Meetings 2016 folders to check 

that there is a copy of the 

Planning Meeting file in each 

Notice the file Planning Meeting is 

still in the Reports 2016 folder 

14.  Close File Explorer and any other 

open windows on the Desktop 

 

 

Renaming files 

Sometimes, you may need to rename a file (the process is exactly the same as renaming a folder). 

For example, you may want to give it a more descriptive file name. 

Step-by-step: 

To rename a file: 

1. Click on the file you wish to rename. 

2. Click the Home tab. 

3. Select Rename. 

4. Type the new name. 

5. Press ENTER. 

6. Your file is renamed. 

Note: You can also right click on the file and choose Rename or press the F2 function 

key on your keyboard. 
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Exercise: 

In the following exercise, you will rename a file. 

1.  In the Data folder, select the file 

Athena Jones. 

The file is highlighted. 

2.  Choose Home tab, choose 

rename. Type John Hunter 

Letter. 

 

3.  Press ENTER. The file is renamed. 

 

Using ‘Undo’ 

A useful feature in any program is ‘Undo’.  You can use Undo to reverse your most recent file 

management actions, such as copying, moving, deleting and renaming files. Undo actions are 

available in File Explorer for multiple levels. 

The Undo command is located on the Quick Access Toolbar (refer to Figure 3-9). If it does not appear 

on the QAT then it will need to be added. 

 

 

Figure 3-9: Quick Access Toolbar (without Undo) 

Step-by-step: 

Displaying Undo button on Quick Access Toolbar; 

1.  If the Undo button is not displayed on the Quick Access Toolbar, choose down 

arrow at end of QAT and select Undo. 

2.  The Undo button will now be on the toolbar; 

 

 

Using the Undo command: 

• Click the Undo button on Quick Access Toolbar or press CTRL Z. 
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Exercise: 

In the following exercise, you will undo renaming a file. 

 1. In the Data folder, select the file 

Reorder Form. Rename the file 

Promotional Orders and press 

ENTER. 

The Reorder Form file is now 

renamed Promotional Orders. 

 2. Choose Undo button on Quick 

Access Toolbar. 

The file is now returned to its 

original name of Reorder Form. 

 

Finding your Files/Folders 

Finding Files/Folders using File Explorer 

It is very easy to forget where you saved a file. In Windows 10, you can search through your drives 

and folders for these “misplaced” files.  

You can use the “Search Documents” facility in File Explorer, which is located in the top right hand 

corner of the window as shown below in Figure 3-10.  Note: indexed file locations will be searched 

much quicker than those that aren’t; search Cortana for ‘Indexing options’ to learn more about 

indexing. 

 

Figure 3-10: Search Facility in File Explorer 

Step-by-step: 

Searching for a file in File Explorer; 

1. Select the folder at the top-level that you wish to search 

For example you may have a folder called Documents with two sub-folders 

underneath called \Training and \Personal.  If you click on the Documents folder 

(top-level) you can at the same time, search the two sub-folders 

2. In the Search Documents box, type the name of the file you are trying to find or any 

a word or text string of any text that may be in the document 

3. All the files that contain that text in the name or in the file contents are displayed. 

4. Just double-click on the file to open it or click the x Close search button in the search 

box to cancel the search and return to your previous view. 

Note: 

When you have run a search, as well as being able to open a document by double-

clicking on it, you can also click your right mouse button on the document and select 

Open file location from the shortcut menu.  This will open the folder that contains 

the document.  

Exercise: 
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In the following exercise, you will search for a file using File Explorer. 

1.  Select the Documents folder The Documents folder displays the 

subfolders 

2.  In File Explorer in the Search box, 

type the name of the file you are 

searching for. Type Spain 

All the files and folders that 

contain the word picnic are 

displayed 

3.  Click the X button in the search 

box to clear the search 

 

Using the Recycle Bin 

The Recycle Bin icon sits on your Desktop. Any files or programs you delete from your local 

Windows 10 device are not immediately deleted but are moved to the Recycle Bin (unless you have 

chosen ‘delete permanently’ when in File Explorer).  

Please note: This only applies to files deleted from your C drive or any other hard fixed drives in your 

PC. Files and/or folders deleted using your Desktop that exist on network drives will NOT go into the 

Recycle Bin. They will be deleted directly and cannot be recovered except through your system back 

up procedure (if you have one).  

Your Recycle Bin has a maximum capacity and when this is reached, older items in it will be 

permanently deleted to make space.  This maximum capacity can be set by right-clicking on the 

Recycle Bin and selecting Properties.  You can also empty the Recycle Bin by right-clicking and 

selecting ‘Empty Recycle Bin’. 

Deleting files to the Recycle Bin 

When you delete an item it is automatically moved into the Recycle Bin. 

Step-by-step: 

To delete files; 

1. In File Explorer, select the file or files you wish to delete. 

2. Select Home tab.  Select Delete drop-down and then Recycle – the file(s) is placed 

in the Recycle bin OR you can press the DELETE key. 

3. Click Yes, to confirm that you want to send the file(s) to the Recycle Bin. 

 

Note: Normally you will be prompted (step 3 above) to confirm that you want to 

delete the file(s).  However, you can turn off this confirmation message - choose 

the Home tab, select Delete drop-down and turn off Show recycle confirmation. 

Once you turn this confirmation off, you will not be asked to confirm deletion.  The 

file(s) will automatically be deleted either permanently or sent to the Recycle Bin. 

Exercise: 

In the following exercise, you will delete files. (Turn on show recycle confirmation 

before doing this exercise). 
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1.  In File Explorer, be sure the Data 

folder is selected 

 

2.  Delete the file Holiday Resorts 

using the Home tab. Select 

Delete and choose Recycle.  

Confirm Yes to place the file in 

the recycle bin 

The file is deleted and placed in 

the Recycle Bin. 

3.  Select the file Cycle Touring.  

4.  Press DELETE on the keyboard and 

confirm Yes to delete the file. 

 

(Turn off Show recycle 

confirmation again if you wish.) 

The file is deleted and placed in 

the Recycle Bin. 

 

 

Recovering a file from the Recycle Bin 

If you change your mind about deleting an item, you can recover it by restoring it from the Recycle 

Bin back to its original location. 

Like other windows, the Recycle Bin can be seen in different views. The Details view allows you to 

see the original location of the file, as well as the date deleted, type, and size. 

Step-by-step: 

To restore a file from the Recycle Bin; 

1. Double-click the Recycle Bin icon on the Desktop. 

2. Select the deleted item to restore. 

3. Select Manage tab, select Restore the selected items. 

The item(s) will be restored to its original location. 
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Exercise: 

In the following exercise, you will recover deleted objects. 

 

1.  On the Desktop, double-click 

Recycle Bin icon. 

The Recycle Bin opens. 

 (If there are many items, you may find it easier to select Details view 

then arrange the order by ‘Date Deleted’ by clicking at the top of the 

column.) 

2.  Select the file Cycle Touring to be 

restored. 

The file is selected and turns blue. 

3.  Choose Manage tab, select 

Restore the selected items or 

right click and choose Restore. 

The file is recovered and placed in 

its original location. 

 

Emptying the Recycle Bin 

You may wish to empty the Recycle Bin, for example if you have just finished a session on a public 

computer. If you are not sure whether you want to permanently delete all the items in the Recycle 

Bin, you can delete selectively. 

To select multiple files, press and hold the CTRL key while you select the desired files. 

Step-by-step: 

To empty the Recycle Bin of all of its contents; 

1. From the Desktop, click your right mouse button on the Recycle Bin. 

2. Select Empty Recycle Bin 

3. Confirm Yes to permanently delete all the items. 

 

To empty the Recycle Bin of selected items: 

1. Open the Recycle bin. 

2. Select the item(s) to be deleted. 

3. Right click and choose Delete OR press DELETE Key. 

4. Confirm Yes to permanently delete the item(s). 
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Exercise: 

In the following exercise, you will empty the Recycle Bin. 

1.  In the Recycle Bin window, select 

Holiday Resorts. 

 

2.  Press DELETE on the keyboard. The Confirm File Delete dialog box 

appears. 

3.  Choose Yes. The file is deleted. 

4.  If there are any more unwanted 

items in the Recycle Bin, choose 

Empty Recycle Bin (to the left of 

the Manage group on the 

Manage tab). 

The Delete Multiple Items dialog 

box appears. 

5.  Choose Yes The Recycle Bin is empty. 

6.  Close all open windows.  

Sharing Information between programs 

When you have more than one program open in Windows 10, you can easily copy information from 

one program into another. Information to be shared between Windows 10 programs can be copied 

from the first program and then stored in a temporary area of Windows known as the Clipboard. 

You can then paste the contents of the Clipboard into a new location. This is particularly useful when 

you want, for example, to place some figures from an Excel worksheet into a report that you have 

created in Word. 

Step-by-step: 

To copy information between programs: 

1. Start the programs you wish to share information between. 

2. Select the text or object you wish to copy. 

3. Select the program’s Copy command or using the keyboard, type CTRL+C.  

4. Switch to the program you wish to paste to. 

5. Position the cursor (insertion point) in the appropriate position. 

6. Select the program’s Paste command or using the keyboard, type CTRL+V 

 

Note: Cut (CTRL-X) and Paste is similar to ‘Copy’ and Paste, but a copy is not retained 

in the source location. 
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Exercise: 

In the following exercise, you will copy the information from Excel and place it in a Word 

document. 

 

1.  Open the Excel file called Coffees 

from the Data folder. 

The Excel spreadsheet Coffees 

appears on the screen 

2.  Switch back to the Data folder 

and open the Word document 

called World Consumption 

The Word document World 

Consumption appears on the 

screen. 

3.  Click underneath the text in the 

Word document (or press Ctrl 

End to move the insertion point) 

The insertion point is moved to 

the end of the Word document 

4.  Switch back to the Excel 

document and select the range 

A1:I5 – this is the range we are 

going to copy. 

The range turns grey to show that 

it is selected. 

5.  On Home tab, select Copy in the 

Clipboard group (or press Ctrl C) 

A copy of the selected range is 

placed on the Clipboard and a 

dotted marquee appears around 

the data 

6.  Switch back to your Word 

document, making sure that the 

insertion point is still at the end 

of the text and on the Home tab, 

click Paste in the Clipboard group 

(or press Ctrl V) 

The information is now pasted 

into the Word document. 

7.  Close and exit Word without 

saving any changes. 

Word closes. 

8.  Close and exit Excel. Excel closes. 
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Assignment 

 

 

1. Open File Explorer. 

2. Select the Documents folder and then open the Data folder. 

3. Change the Data folder view to Large icons. 

4. Change the Data folder view back to Details. 

5. Use View tab to Sort the files in the Data folder by Date created. 

6. Use View tab to Sort the files in the Data folder by Name. 

7. In the Data folder, create a new folder named Meetings. 

8. Copy the file Coffees into the Meetings folder. 

9. Rename the file Reorder Form (it may also be called Promotional Orders) to Orders. 

10. Move the file Centennial Meetup into the Memos folder. 

11. Undo the move you just performed. 

12. Use Search (File Explorer) to find the Microsoft Word Document containing the text “Spain” 

Close the search. 

13. View the contents of the file Holiday Resorts by double-clicking it. 

14. Close the Word window. 

15. Open the file Coffees (you could Search for it).  Using copy and paste, copy the first four 

columns (A1:D5) and place them at the end of the Word document called Orders.  Save the file 

and close Word. Close Excel. 

16. Delete the files Holiday Resorts and Orders. 

17. Recover these files from Recycle Bin and restore them to their original locations. 

18. Empty the Recycle Bin. 

19. Close any open windows on the Desktop. 
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Module 4: Customising Windows 10 

Objectives: 

• Customising Windows 10 (Page 61) 

• Working with Shortcuts (Page 70)  

• Customising the Lock screen (Page 72)  

• Customising the Start screen (Page 74) 

• Working with the Taskbar (Page 79)  

Customising Windows 10 

Windows 10 has many features that you can customise to make it suit your personal requirements 

more closely. For example, you can change the appearance of your Desktop and Start menu, 

customise your power settings and adjust your mouse settings to suit the way you work. The Start 

menu has now been reintroduced and a new ‘Action Centre’ pane and ‘Settings’ dialog have been 

introduced, incorporating the most commonly used functions of Control Panel plus a few new ones. 

 

Settings 

There are two ways to access the Settings dialog box, illustrated in Figure 4-1 below 

 

 

Figure 4-1: The Settings Dialog box 
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Step-by-step: 

To access Settings using the Start Menu; 

1. Click on the Start button. 

 

Figure 4-2: The Start Menu, ‘Settings’ option 

2. Click on Settings in the Start menu. 

The Settings dialog box appears as shown in Figure 4-1. 

3. Click the item you want to change. 

4. Make changes as required. 

5. To go back a screen, click the ���� Settings arrow in the top-left corner of the dialog 

box. 

6. To return to the Settings home screen click the Settings icon, also in the top-

left corner of the screen. 

7. When you have finished, click the Close button and your settings will be 

automatically saved.  

To access Settings using the Action Centre;  

1. Click the Action Centre button on the right-hand side of the Task bar. 

The Action Centre appears; 

 

Figure 4-3: The Action Centre Pane 

2. Click the All Settings button at the bottom of the Action Centre. 

 

Settings 
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Settings Options 

System Display - choose settings for multiple displays and change screen 

resolutions 

Notifications & actions – choose whether to enable/disable notifications 

for certain apps and organise ‘Quick Actions’ (in the Action Centre) 

Apps & features – uninstall or move an app 

Default apps - set default apps for photos, music, internet etc 

Power & sleep – organise power settings 

Storage - shows free disk space & set ‘Save’ locations 

System also covers Tablet Mode and Offline Maps 

Devices Printers & scanners – add and configure devices 

Mouse and touchpad – configure pointer devices 

Devices also covers Pen, USB, Typing and Proofing options 

Network & Internet WiFi connections 

Data usage over last 30 days 

Also covers VPN, Dial-up, Ethernet and Proxy setup 

Personalisation Background – set a Desktop background picture 

Colours – set a colour scheme (includes high contrast settings) 

Lock screen – settings and timings 

Themes – save your background, colours etc to a Theme (can also include 

mouse pointer and Desktop icon settings) 

Start – customise settings for Start menu 

Accounts Your email and accounts – add an account, account picture etc 

Sign-in options – password, PIN, Picture password 

Work access – add additional work or school accounts 

Family & other users – add other and family member users (includes child 

settings) 

Sync your settings – synchronise your settings with your other Windows 

10 devices, such as tablet and phone 

Time & language Date & time – set time zone and formats 

Region & language – select country, region and language 

Speech – Choose a language and voice for text-to-speech (also includes an 

option to set up microphone for speech recognition) 

Ease of Access The following tools are for those that need assistive technology to help use 

a computer;  

Narrator – enable and customise settings for Narrator screen reader 

Magnify – settings for screen magnifier and tracking 

High Contrast – choose a Theme for high contrast 

Closed captions – format settings for closed captions 

Keyboard – assistive settings for keyboard (includes sticky keys) 

Mouse – settings for pointer size, pointer colour etc 

Other options – includes cursor thickness & disable Windows animations 
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Privacy Privacy includes a range of settings that allow you to customise (enable or 

disable) the way your computer interacts with devices, applications, email 

and certain websites.  These settings include; 

Location – disable/enable ‘location aware’ for all apps or certain apps (eg. 

Camera, Cortana) 

Camera – disable/enable built-in camera or webcam for all apps or certain 

apps (eg Skype, OneNote) 

Call history – Enable/disable call history for Messaging and Skype etc 

Background apps - choose which apps can run in background (turning 

some of these off can conserve power and resources) 

Update & security Windows Update – current status of Windows updates. In Windows 10, 

deferring updates is not an option 

Windows Defender – Windows 10 now runs Defender (an anti-virus 

program) by default (if you install another anti-virus program, the 

Defender settings will be disabled) 

Backup – enabling backup using File History to NAS (Network Attached 

Storage) is ideal, or back up to a shared drive on a network 

Recovery – options for resetting your PC in case of poor performance 

Activation – Windows activation (includes option to change product key) 

For developers – options to enable your device for development  

 

Selecting a background 

Backgrounds can make your Desktop more interesting and add a ‘personal touch’. The Background 

setting adds colours and pictures to the Desktop. You can also create your own background using a 

graphics application or imported photos or scans. 

 

Figure 4-4: Changing the Desktop background & colours 

Step-by-step: 

To change the background from the Settings dialog; 

1. Choose Settings or All Settings from either the Start menu or the Action Centre. 
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2. Click Personalisation in the Settings dialog box (see Figure 4-4). 

3. In the Background drop-down list, you can select ‘Picture’, ‘Solid Colour’ or ‘Slide 

Show’ 

If you select ‘Picture’, you are given a selection of pictures to choose from or you can 

‘Browse’ to a picture on your device. You can also select how the picture sizes to fit 

the screen (eg. Fill, Stretch, Tile etc)  

4. Click Colours from the menu on the left of the dialog.   

Windows will automatically pick an accent colour from the Desktop background – 

you will notice this in the Start menu. However, if you wish a different colour can be 

selected from a colour palette. 

Similarly, you can choose whether this colour shows in the Start Menu, Action 

Centre and Title bar; and a third option lets you determine whether the same 

locations show the colour as solid or semi-transparent. 

5. Close dialog box to save your changes. 

Changing background from the Desktop: 

1. Right-click an empty area of the Desktop. 

2. In the shortcut menu, click on Personalise to open the Personalisation dialog box in 

Settings. 

3. Continue as before. 
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Exercise: 

In the following exercise, you will select a background picture and disable the 

transparent option for colour: 

 

1.  Right-click an empty area of the 

Desktop. (Tablet Mode: click the 

Action Centre button and then All 

Settings.) 

A shortcut menu appears. (In 

Tablet mode the Settings dialog 

appears.) 

2.  Select Personalise (Tablet Mode: 

Personalisation) 

The Personalisation dialog box 

appears. 

3.  Select Background on the left of 

the dialog. 

The Desktop Background page is 

displayed. 

4.  In the Background drop-down list 

check that Picture has been 

selected, and then select a 

different picture from the default 

picture. 

The selected picture will now 

appear on the Desktop and in the 

preview window. 

5.  Select Colours on the left of the 

dialog. Check that the first option 

Choose a different accent colour 

from the colour palette.  

 

Tiles in the Windows Start menu, 

will now show in your chosen 

colour. 

6.  Close the dialog box. Dialog box closes and new 

settings are saved. 

 

Power Settings 

Power & Sleep in the Settings dialog lets you determine when your computer screen turns off and 

when your PC goes into sleep mode, thus conserving power (and battery charge). 

Step-by-step: 

1. Select Settings via the Start Menu or All Settings via the Action Centre. 

2. Click System in the Settings dialog box. 

3. Click on Power & sleep; 
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Figure 4-5: Power & sleep settings (PC Version) 

 

4. Under ‘Screen’ use the drop-down menu to select the required number of 

minutes or hours before the screen turns off (this can also be set to ‘Never’). 

5. Under ‘Sleep’ use the drop-down to select the required number of minutes or 

hours before the PC powers down and ‘sleeps’ (this too can be set to ‘Never’). 

Note: on a laptop or tablet you will see additional settings for when the device is 

running on battery power. 

6. Close the dialog box to save your settings. 

Note: for additional power settings – see Control Panel below 

Control Panel 

The old Control Panel still exists, though it is generally used for more advanced settings and the 

Settings dialog box as described previously is now used for customising the most commonly used 

settings. For example, if you wish to disable/enable your password when waking the computer up 

from sleep mode or if you wish to change the power button settings on your PC you would need to 

use Control Panel.  Tip: the new Settings dialog box is the same on Windows 10 tablets and 

Windows 10 phones, making it easier to remember where settings are on various devices. 

Step-by-step: 

Use Control Panel to adjust the function of the Power button on your computer; 

1. Click the Start button 

2. In the alphabetical Apps list, scroll down to and click on Windows System and then 

select Control Panel. 

(If you are going to use Control Panel regularly, it might be a good idea to add it to 

the Start Menu – see Module 1). 

Note – there is often a Control Panel link from the Settings dialog box when more 

advanced settings are available. 
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3. In the Control Panel dialog box, click on Power Options 

4. Select ‘Choose what the power buttons do’ from the menu on the left of the dialog 

box. 

5. Make your selection and then click the Save Changes button at the bottom of the 

dialog box. 

6. Close the dialog box. 

Controlling the Mouse 

Windows 10 allows you to adjust the way the mouse pointer displays, moves and selects items on 

the screen. These settings can be controlled from both the Settings dialog and from the Control 

Panel (‘Mouse’ settings).  These are illustrated in both Figures 4-6 and 4-7. 

The left mouse button is the default button you use to select items. If you are using the mouse with 

your left hand, you might prefer to use the right mouse button. As in previous versions of Windows, 

you can swap the left and right buttons over. 

In the ‘Settings’ dialog box you can switch the primary button for your mouse from left to right (and 

vice-versa) and choose how many lines/rows to scroll at a time. In the Control Panel window, you 

adjust the double-click speed and change the shape and speed of the mouse pointer. 

  

Figure 4-6: Mouse & touchpad settings Figure 4-7: Mouse properties 

in Control Panel 

Step-by-step: 

To adjust the number of lines to scroll using the mouse-wheel and to control the mouse 

double-click speed: 

1. Select Settings or All Settings either from the Start menu or from the Action Centre. 

2. In the Settings dialog, click on Devices and then click on Mouse & touchpad (see 

Figure 4-6). 

3. Check that the primary button is set as you prefer (either ‘Left’ for right-handed 

users or ‘Right’ for left-handed users). 
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4. Under Roll the mouse wheel to scroll – you can change the option to ‘One screen at 

a time’ or... 

5. Adjust the slider under ‘Choose how many lines to scroll each time’ (from 1 to 100; 

the default is 3) 

6. Under ‘Related settings’, click on Additional mouse options. This will open the 

‘Mouse Properties’ dialog in Control Panel (see Figure 4-7) 

7. On the Buttons tab of the dialog box drag the slider between ‘Slow’ and ‘Fast’ to 

adjust the double-click speed of the mouse. 

8. Test the double click speed on the yellow folder icon. 

9. Choose OK to save your settings. 

To control mouse pointer trails: 

1. Select the Control Panel and then click Mouse to open the ‘Mouse Properties’ dialog 

box. 

2. Click the Pointer Options tab.  

3. In the Visibility area, select the Display Pointer Trails check box. 

4. Click OK to save your settings. 

Exercise: 

In the following exercise, you will edit the number of lines the mouse wheel scrolls, 

change the mouse double-click speed, and then you will add and remove mouse pointer 

trails. 

1.  Select Settings or All Settings 

either from the Start menu or 

from the Action Centre. 

The Settings dialog box appears. 

2.  Click on Mouse & touchpad. The Mouse settings appear. 

3.  Use the slider to adjust ‘...how 

many lines to scroll each time’ – 

change it to just one line.  Test 

this out by opening Excel – use 

the mouse wheel to scroll up and 

down an empty worksheet – 

notice it now only scrolls one line 

at a time. (This does not apply to 

touch screen devices) 

The mouse wheel now only scrolls 

one line at a time (eg in a Word 

document or one row in a 

spreadsheet).  (The default 

setting was 3 lines.) 

4.  Click on Additional mouse 

options to open Mouse 

Properties in Control Panel. 

The Control Panel ‘Mouse 

Properties’ dialog box opens. 
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5.  On the Buttons tab of the dialog 

box use the slider to adjust the 

‘Double-click’ speed to ‘Fast’.  

Try it out by double-clicking on 

the yellow folder.  Now adjust 

the speed to medium, or to a 

speed that suits you.  Test it out 

again, by double-clicking the 

yellow folder. 

The mouse double-click should 

now be adjusted to suit you. 

6.  Click the Pointer Options tab. The Pointer Option setting 

appear. 

7.  In the Visibility area, select the 

Display pointer trails check box.  

Alter settings as required. 

A mouse pointer trails is selected. 

8.  Move the mouse pointer across 

the screen. 

Mouse pointer trails appear. 

9.  In the Pointer trails area, 

deselect the Show pointer trails 

check box. 

 

10.  Choose OK. The Mouse Properties dialog box 

closes. 

11.  Close the Control Panel window.  

 

Working with Shortcuts 

(Desktop mode) 

Shortcuts are icons that allow you to quickly open files and folders from the Desktop and other 

locations. Shortcuts increase your efficiency because they eliminate having to search through your 

folders manually trying to find the folder or file that you regularly use.  A shortcut can be a link to a 

file, a folder or an application. 

Creating Shortcuts to Files and Folders 

A shortcut is indicated by an arrow as shown in Figure 4-8 and Figure 4-9 below. 

  

Figure 4-8: Shortcut to folder on 

the Desktop 

Figure 4-9: Shortcut to a file on the 

Desktop 

Step-by-step: 

To create shortcuts to the Desktop; 

1. Open File Explorer. 



Windows 10 – Introduction Module 4: Customising Windows 10 

www.ldnh.co.uk  Page 71 of 85 

2. Click your right mouse button click on the file or folder you wish to create a shortcut 

to from your Desktop. (On touch-screen devices, press and hold on the file or 

folder). 

3. Point to Send to and then select Desktop (create shortcut). 

4. Take a look at your Desktop and you can now see your shortcut. 

 

Exercise: 

In the following exercise, you will create shortcuts to a folder and an app. Then, you will 

use a shortcut to start the app.  Make sure you are in Desktop mode before starting 

this exercise. 

1.  Open File Explorer making sure 

the Desktop is visible 

 

2.  Choose the Documents folder 

and, select the Data folder 

The folder’s contents are 

displayed in the File list. 

3.  Right click (or press and hold) 

on the folder and point to Send 

to and then select Desktop 

(create shortcut) 

A new Shortcut icon now appears 

on your Desktop. 

4.  Close File Explorer  

5.  Next, you will create a shortcut 

on the Desktop to the 

Windows Sticky Notes 

program. 

First, make sure that your 

desktop is visible – If you have 

any programs/windows open – 

either close them or minimise 

then. 

Click Start to view your list of 

apps 

 

 

 

 

 

 

 

All your applications are listed in 

alphabetical order 

6.  Scroll down to the letter ‘W’ 

and click on Windows 

Accessories. 

The Windows Accessories apps 

will now show 

7.  Drag Sticky Notes and drop it 

onto your Desktop. 

 

Note: if you haven’t tried the 

‘Sticky Notes’ app – give it a go. 

It’s great fun – just like 

electronic post-it notes! 

When you release your mouse a 

shortcut icon will appear on your 

Desktop to the Sticky Notes app. 

Renaming Shortcuts 

Once you have created a shortcut, you may want to give it a new name. You rename a shortcut the 

same way you rename a file. 
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Step-by-step: 

To rename shortcuts; 

1. Right click (or press and hold) on the shortcut. 

2. Choose Rename. 

3. Alternatively, you can select the shortcut and then press the F2 function key on your 

keyboard 

4. Type the new name and press ENTER. 

Note – renaming a shortcut does not rename the file or folder that it is linked to; this 

retains its original name 

Exercise: 

In the following exercise, you will rename the Data shortcut. 

1.  On the Desktop, select the 

shortcut to Data. 

 

2.  Right click (or press and hold) on 

it and choose Rename. 

The shortcut name is selected. 

3.  Type; 

 Data files 

 

4.  Press ENTER. The shortcut is renamed. 

Deleting shortcuts 

If you no longer need a shortcut, it can easily be deleted. 

Step-by-step: 

To delete shortcuts; 

• Select the shortcut (or press and hold) and select DELETE. 

The shortcut is deleted (the original file/folder remains with its contents). 

Exercise: 

In the following exercise, you will delete the shortcuts you created. 

1.  Select the data folder shortcut.  

2.  Press DELETE.  The shortcut is now deleted and 

placed in the Recycle bin. 

 

Customising the Lock screen 

Changing the Lock screen 

When you turn your device on, Windows 10 will first show you your ‘Lock’ screen. This screen can be 

customised (refer to Figure 4-10). The Lock screen shows a picture, current date and time and 
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battery life (for mobile devices). It can also show network status and quick status notifications for up 

to seven different apps.  The Lock screen will also appear when you wake it from sleep. 

 

Figure 4-10: Personalizing the Lock screen 

Step-by-step: 

To change/add screen apps to the Lock screen; 

1. Select Settings or All Settings from the Start menu or from the Action Centre. 

2. Click on Personalisation. 

3. Select the Lock Screen option from the left-hand side of the screen. 

4. Under ‘Choose an app to show detailed status’, click the icon and choose whichever 

app you prefer (eg. Calendar – this is the default, Mail or Facebook). 

5. Under ‘Choose apps to show quick status’, click the icons and choose your preferred 

apps (including ‘None’, ‘Weather’, ‘Facebook’ etc). If necessary, click on + (plus) sign 

to select additional apps. 

Your lock screen will now be updated. 

6. To view your changes, shut down and restart Windows 10 on your PC or swipe using 

your tablet or mobile device. 

 

Forcing the Screen to Lock 

If you work in a busy office and you need to quickly walk away from your computer, you can force it 

to lock without waiting for it to sleep. 

Step-by-step: 
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• To force your computer to lock you can either press WINDOWS KEY  + L or press Alt-Ctrl-Del 

on your keyboard and then select Lock. 

 

Customising the Start screen 

Adding a data folder to Start screen 

In Windows 10, in addition to Live tiles that launch applications, the Start screen can also display 

tiles that open data folders. These can sometimes be a useful alternative to creating shortcuts to 

folders on your Desktop as some organisations don’t allow customisation of employees’ desktops. 

  

Figure 4-11: Pinning Documents folder to Start Screen 
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Step-by-step: 

Adding an item to the Start screen; 

1. Right-click (or press and hold) on the data folder that you wish to add (eg. 

Documents). 

2.  Choose Pin to Start. 

The tile now appears in the Start menu – it can be moved and resized (see 

Module 1). 

Removing the data folder from Start screen 

Just as you can unpin a live application/app tile from the Start menu, you can also unpin a tile that 

opens a data folder. 

After a while, you may find that you are using a new program/folder/item instead of one of those 

that you initially installed on your Start screen. You can add and remove it at any time.  

  

Figure 4-12: Unpinning the Documents folder from Start Screen 

 

Step-by-step: 

To remove the data folder from the Start screen; 

1. Display the Start screen. 

2. Right click (or press and hold on touchscreen device) on the tile you want to 

remove. 
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3. Select Unpin from Start (on touchscreen device, tap the ‘Unpin’ icon) 

The tile is removed. 

 

Exercise: 

In the following exercise, you will add the Data folder to the Start screen. 

1.  Launch the File Explorer. File Explorer window opens. 

2.  Right click (or press and hold on a 

touchscreen) Data folder, under 

Documents on This PC. 

The Data folder is now selected 

showing the shortcut menu. 

3.  Choose Pin to Start. The Documents folder appears on 

the Start screen. 

4.  Now unpin it. The Documents folder is now 

unpinned. 

 

Adjusting the Start Menu Width 

By default, the Start menu’s right-hand side is three tiles wide, which means that you can have three 

medium-sized tiles displayed side-by-side. If you have a larger screen or you simply want a larger 

Start menu, you can alter the width by dragging the border. 

 

Figure 4-13: The wider Start Menu 
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Step-by-step: 

When working in Desktop mode on a PC; 

1. Click the Start button to display the Start menu. 

The Start menu appears 

2. Move the mouse pointer over to the right-hand side of the Start Menu (where 

there is usually a scrollbar). 

The scrollbar appears 

3. Position the mouse pointer on the right-hand side and when a double-headed arrow 

pointer appears, drag the mouse to the right to make the menu wider. (Dragging to 

the left would make the menu narrower.) 

The Start menu widens and the tiles reorganise themselves 

4. Release the mouse when you have resized the menu to your desired width (the 

maximum possible is the width of your display) 

The Start menu now appears as a wider menu 

When working in Tablet mode with a touchscreen; 

• Press and hold down on a tile and then drag it to a new position. 

Start Categories  

In Windows 10 your tiles can be divided into different categories. In fact, you will see that there are 

already some category titles in your Start menu.  New ones can be created and you can also 

rename existing categories. 

 

Figure 4-14: Adding a new Category 

Step-by-step: 

When working in Desktop mode on a PC; 

1. Click the Start button to display the Start menu. 

The Start menu appears 
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2. Drag one of the existing tiles (one that you wish to place in a new category) to 

either the far right side of the Start menu or the bottom of the Start menu.  When 

a solid coloured bar appears, release the mouse. 

The tile is moved and a Category bar appears above the tile 

3. Click in the Category bar (it will display the text ‘Name group’ as you hover your 

mouse over the bar). Type a suitable category name. 

The tile now appears in a named Category group 

Note: 

• If required, you can move the category group by dragging the category bar – 

any tiles within the category will move with the group. 

• If you wish to rename a category heading, simply click on the heading and type 

over the text. 

When working in Tablet mode with a touchscreen; 

• The process is much the same only you press and hold a tile and drag to the far right 

or the bottom of the Start screen, when a Category bar appears. 

Exercise: 

In the following exercise, you will adjust the width of the Start menu and create a new 

Category group. 

1.  Click the Start button to display 

the start menu (Desktop mode 

only). 

The Start menu appears. (Desktop 

mode only) 

2.  Drag the right-hand side of the 

menu until the menu is 9 

medium-sized tiles wide. 

(Desktop mode only). 

The Start menu has now resized. 

3.  Drag one of the existing tiles 

down to the bottom of the Start 

menu and release the mouse 

when a coloured bar appears. 

The tile has now moved into a 

new Category group 

4.  Click above the tile, on the 

Category bar and type the 

Category name: Test Category 

and then press the ENTER key. 

The new Category group now has 

a name. 

5.  Move the tile back to its original 

location (outside the new 

Category group). 

The new Category group will 

disappear as there are no tiles in 

that group. 
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Working with the Taskbar 

As in earlier versions of Windows, the Windows 10 Taskbar can be customised.  This can include 

the look of taskbar buttons, how they group together when you have several documents open in any 

one application and what additional icons display on the Taskbar. 

Just as you can pin apps and applications to the Start menu, you can also pin them to the Taskbar. 

Pinning Applications to the Taskbar 

The following steps show you how to pin an application to the Taskbar using Cortana and how to pin 

to the Taskbar using the Start menu. 

Step-by-step: 

Using Cortana; 

You can pin an app/application directly to the taskbar for quick and easy access. 

1. Click in the Cortana search box and type the name of the application that you are 

searching for; 

  

Figure 4-15: Cortana Search Results  

Cortana displays the results of your search, with the ‘best match’ at the top of the list. 

2. Click your right-mouse button on the application (or press and hold down if using 

touchscreen device) and select Pin to taskbar from the shortcut menu. 

Your application is now pinned to the Taskbar (see Figure 4-16) 

 

 

Figure 4-16: The Taskbar 

 

Note: If you are using a touchscreen device you may need to enable the display of 

apps/applications on the Taskbar: Press and hold on the Taskbar and then select Show 

app icons from the shortcut menu. 
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Using the Start Menu; 

1. Click the Start button to display the Start menu (Desktop mode only). 

The Start menu appears 

2. Scroll down the alphabetical list of All Apps to the application you wish to add to 

the Taskbar. 

3. Click your right-mouse button (or press and hold) on the application, point 

to/press on More > and then click on Pin to Taskbar. 

Your application is now pinned to the Taskbar 

 

Unpin an application/app from the taskbar: 

• To remove a pinned app from the taskbar, right click (or press and hold) on the item 

on the taskbar select Unpin from taskbar.  

 

Exercise: 

In the following exercise, you will pin an application to the Taskbar using both Cortana 

and the Start menu. You will also unpin an application. 

1.  Click in the Cortana search box 

and type Publisher. 

Note: If you don’t have the 

Microsoft Publisher application 

on your computer, then you could 

search for the Paint app (which 

comes with Windows) 

Cortana will display the search 

results in a list. 

2.  Click your right-mouse button (or 

press and hold) on Publisher 

under ‘Best match’ and select Pin 

to taskbar. 

The Publisher application is now 

pinned to the Taskbar. 

3.  Test it out – click on the Publisher 

button to start the program and 

then close it down. 

 

4.  Now click your right-mouse 

button (or press and hold) on the 

Publisher button on the Taskbar 

and select Unpin from taskbar. 

The Publisher button is removed 

from the Taskbar.  

5.  Click the Start button to display 

the Start screen 

The Start screen appears. 

6.  Scroll down your list of All Apps 

and then find Publisher (it may be 

under ‘P’ for Publisher, or may be 

under ‘M’ for Microsoft Office). 

(If you’re looking for Paint, it is 

storied in ‘Windows Accessories’) 

The All apps list appears 
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7.  Click your right-mouse button (or 

press and hold) on Publisher then 

click More > and then click Pin to 

Taskbar. 

The Publisher application is now 

pinned to the Taskbar. 

8.  Unpin Publisher from the Taskbar 

as in step 4. 

 

 

Taskbar Settings (Desktop mode) 

In Desktop mode, the Taskbar Settings dialog box lets you change the size of the taskbar buttons and 

select how to group multiple documents/files together on the Taskbar. You can also rearrange the 

buttons on the Taskbar. 

Step-by-step: 

Rearranging taskbar buttons; 

• To rearrange the order of buttons on the taskbar, drag a button from its current 

location to a different location on the taskbar. You can rearrange buttons as often as 

you like. 

 

Moving and locking/unlocking the taskbar: 

1. Usually, you can find the taskbar at the bottom of the Desktop, but you can move it 

to the sides or top of the Desktop. Before you can move the taskbar, you need to 

unlock it. 

2. Press and hold or right-click an empty space on the taskbar. If Lock the taskbar has a 

check mark next to it, the taskbar is locked. You can unlock it by tapping or clicking 

Lock the taskbar, which removes the check mark. 

3. Tap an empty space on the taskbar, and then drag it to one of the four edges of the 

Desktop. When the taskbar is where you want it, let go OR release the mouse 

button. 

4. To lock the taskbar into place, press and hold or right-click an empty space on the 

taskbar, and then tap or choose Lock the taskbar so that the check mark appears. 

This helps make sure that the taskbar doesn't accidentally get moved or resized. 
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Change how taskbar buttons appear: 

 

 Figure 4-17: Taskbar Settings 

 

You can change the buttons on the taskbar to ‘small’ buttons; which will allow you to fit 

more buttons on the taskbar.  The taskbar can be set to automatically hide itself when 

you are not using it. You can also choose how buttons are grouped together when there 

is more than one window open, and change the size of taskbar button icons. 

1. Right click on Taskbar and choose Settings, this displays the Taskbar Settings dialog 

box (see Figure 4-17). 

2. Under ‘Automatically hide the taskbar...’ (for desktop or tablet mode): 

(see (a) in Fig 4-17) - change this option to ‘On’ if you want the taskbar to collapse 

when not in use.  Simply move mouse pointer back to the edge of the screen and 

the taskbar will reappear. 

3. Under ‘Use small taskbar buttons’ (see (b) in Figure 4-17) – set this to ‘On’ in order 

to make the taskbar buttons smaller.  This enables you to add more taskbar 

buttons without the taskbar becoming ‘cluttered’ 

4. Under ‘Combine taskbar buttons’ (see (c) in Figure 4-17) select one of the options 

from the drop-down list: 

• Always hide labels: This is the default setting. Each app/application appears as a 

single, unlabelled button, even when multiple windows for an application are 

open. To switch between the windows for that application – either tap or hover 

the mouse over the button on the Taskbar and when separate windows appear 

as thumbnails – click/tap on the thumbnail for the particular document that you 

wish to switch to. 
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• When taskbar is full: This setting shows each window as an individual, labelled 

button. When the taskbar becomes crowded, applications with multiple open 

windows collapse into a single button. Tap or clicking the button displays a list of 

the windows that are open. 

• Never: This setting shows each window as an individual, labelled button, and 

never combines them, no matter how many windows are open. As more apps 

and windows open, buttons get smaller, and eventually the buttons will scroll.  

5. Click the close button to save your settings. 

 

Notifications area 

The notifications area (previously called ‘Systray’) is located at the far right side of the taskbar and it 

contains app/application icons that provide status and notifications about things like 

headset/speaker volume, incoming email, updates, and network connectivity. You can change which 

icons and notifications appear there.  By default, some of these are hidden; however, you can 

choose which icons are hidden and which are permanently on show. 

 

 

• To hide an icon in the notifications area: drag the icon from the visible area and drop it onto 

the hidden icons symbol (^) 

• To make a hidden icon visible in the notifications area: click the hidden icon symbol (^) to 

show all hidden icons in a pop-up menu, and then drag onto the visible notifications area  

 

Take a look (‘Peek’) and show Desktop: 

You can use the Show Desktop button at the right end of the taskbar to minimize your open 

windows and get to the Desktop quickly. If you're using a mouse, you can also use it to preview 

(‘Peek’) the Desktop without closing or minimizing your open windows. 
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• To minimize all of the open windows on the Desktop, click the ‘Show Desktop’ 

button on the far right-hand side of the Taskbar.  Click the same button again to 

restore all the windows. 

• If you are using a mouse, you can simply hover your mouse pointer over the Show 

Desktop button and you will get a ‘peek’ of the Desktop. Moving the mouse pointer 

away from the same button will restore any open windows again. 

 

Taskbar Properties (Tablet Mode) 

In Tablet Mode, the Taskbar does not have as many properties that you can edit. For example, you 

cannot change the size of the buttons on the Taskbar, however you can choose how many buttons 

to display and remember (from Module 1) that there is a button to switch to Task view. 

Step-by-step: 

To control how many icons you display on the Taskbar and use the Task view button in 

Tablet mode; 

 

1. Press and hold on the Taskbar to display the Taskbar shortcut menu. 

2. Select from the three tick boxes (you may select all three if you wish); 

� Show app icons (recommended) 

� Show all notification icons 

� Show touch keyboard button 

3. Press the Task view button on the Taskbar to show all open windows tiled 

side-by-side. Press the same button again to return to your previous view or tap one 

of the tiled windows to switch to that window. 
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Assignment 

 

1. Open Settings. 

2. In the Personalisation settings, select a (different from default) ‘Picture’ for the background. 

3. In Colours, choose a different accent colour. (Windows will no longer choose an accent colour 

from your background picture). 

4. Go back to the main Settings window and select System. 

5. Click on Power & Sleep and set the Screen to turn off after 15 minutes (default is normally 10 

minutes and set Sleep to 30 minutes (default is normally 20 minutes). 

Note: if you are using a laptop or tablet, only change the settings under ‘Screen’ and ‘Sleep’ for 

‘when plugged in’ (not ‘on battery power’). 

6. Go back to the main Settings window and select Devices. 

7. Under Mouse & touchpad, change the settings so that when rolling the mouse wheel to scroll 

your mouse will roll 5 lines/rows at a time (the default is 3 lines). 

8. Test this out in Excel (only relevant when using a mouse with a scroll wheel). 

Note: The following step is not relevant for those using a touchscreen device: 

9. Still in ‘Mouse & touchpad’ settings, click the Additional mouse options link to open the ‘Mouse 

Properties’ dialog box. Click the Pointer Options tab and tick the check box ‘Show location of 

pointer when I press the CTRL key’. Click OK to save your settings.  

Test this out – press the CTRL key and notice the animated mouse pointer. (Most useful when 

you’re demonstrating something on the screen to somebody else). 

10. Use File Explorer to create a shortcut on the Desktop to the Data folder (Desktop mode only). 

11. Rename the shortcut My Data. 

12. Create a shortcut on the Desktop to the one of the files in your My Data folder. 

13. Delete the two new shortcuts you have created (one to a file and the other to the My Data 

folder) on the Desktop. 

14. Reset all the changes you made in steps 1. to 8. (background picture, colours, power & sleep 

settings and mouse settings). 

15. Close all open windows. 

 


